A BEGINNER’S GUIDE TO SPREADSHEETS:  EXCEL

by

Steve Marsden (www.chemtopics.com)

A.   Introduction

[note:  These instructions, except where noted, are for the use of Excel on PCs.  There are differences in behavior and use on the Macs, but most of these are minor and will probably be obvious to regular Mac users.  However, file structures for various versions of Excel are sometimes NOT compatible.  The message?  Be careful or you will lose your work.]

GETTING STARTED

Double-click on the Microsoft Excel icon and Excel will start initializing.  Wait for the word Ready in the lower left-hand corner before beginning to work.

THE SPREADSHEET

As you will see on the screen a spreadsheet consists mainly of a grid of cells arranged in numbered rows starting with 1 at the top and also in columns, beginning with A at the left.  A cell is a slot for information which may be either text (words), numbers, or mathematical formulas.  A spreadsheet is perhaps best thought of as a phenomenal scratch pad on which each little cell is a sophisticated calculator that is able to display both calculations as well as notes describing them.  As such, it is a powerful tool that to some extent eliminates the need for programming skills in attempting mathematical modeling.  It is also able to relieve the tedious task of repetitive calculation--something for which any student should be grateful!

WINDOWS CONVENTIONS AND EXCEL

You can easily move around the cell grid by using the arrow keys on the keyboard.  PageUp and Pagedown will move you vertically through screens of cells quickly.  To move horizontally by screen widths, hold down the Alt key while pressing PageUp or PageDown.  You can scroll through the cell grid by moving the mouse pointer [while on the cell grid the mouse pointer usually looks like a cross as opposed to an arrow] to the scroll bars on the right hand side of the screen and the bottom right corner.  Positioning the pointer on the arrow-head and pressing the left mouse button will make the grid scroll (try it!).  You can also position the pointer on the square marker box within the scroll bar and drag it to another position by holding down on the left mouse button as you move it.

To move to the beginning of the sheet (i.e., A1), you can press Ctrl-Home on the keyboard (hold down the first key while pressing the second).

In the course of developing a spreadsheet you will frequently need to select certain cells or a region of cells.  The currently selected cell has a bold border and you can select any cell by moving the mouse pointer to that location and pressing the left button.  To select a series of cells (row or column), position the mouse pointer on the first cell you want, press the left button and hold it as you drag through the cells you want to select.  They will be blackened.  Release the mouse button when you reach your destination.

To select a block of cells, follow the procedure for selecting a column but move diagonally across the cells to the opposite corner of the block you want selected.

To select non-contiguous areas, hold down the Crtl key as you make the selections.

To select an entire row or column click on the number or letter marker.  To select the entire sheet, click on the “all” button (upper left hand corner where A and 1 meet.).

Selection can also be done from the keyboard, moving to the first cell you want using the arrow keys and then holding the Shift key down as you use the arrows keys to highlight the area you want.

To cancel a selection, simply click the mouse pointer on a non-selected area.

Throughout this tutorial reference will be made to the bar of icons near the top of the screen.  These icons are like buttons which perform special tasks.  Most of them duplicate functions found on the pull-down menus above them but allow quicker access to the command sequences.  Although many of the icons will be discussed in these pages, it is easy to forget which little picture stands for what function.  If you can’t remember, all you have to do is pause over the icon with the mouse pointer and a little box will appear that tells you the function of that particular icon.

Some commands are best accessed through the extensive pull-down menus that begin with File across the top of the screen.  If you place the mouse pointer over one of these words and press the left button, a list of commands will appear below.  These can be accessed in a similar fashion and some lead into an amazing array of options.  All of which brings to mind perhaps the most important menu option:  Help.  There is extensive on-line help available from the computer along with examples of how to do specific things.  When in doubt, by all means ask an instructor.  But when on your own, try Help.

MAKING CELL ENTRIES
To make an entry all you have to do is move into a cell and start typing (well, almost).  Try typing your name in cell A1 (always press Enter after typing an entry--or use the arrow keys to move to another cell--so the computer knows you are finished).  Although your name is probably longer than the current width of the cell all of it will appear (covering over cells to the right).  Now move the active cell to B1.  When you type anything in this cell, you will no longer be able to see all of the entry in A1, but it is still there.  To see that is so all you have to do is move the active cell back to A1 and look in the formula bar which is just above the column headings.  If you want to display your full name in column 1 you will have to make it wider.  The easiest way to do this is to move the mouse pointer to the line segment between A and B in the column headings.  A double arrow will appear.  If you double-click the left mouse button the column is automatically sized for the widest entry it contains.  You can also size the column manually by holding the mouse button down and dragging the column border.

You can also format the width of a selected series of columns by choosing from the Format pull-down menu the option for Column.  More general formatting hints follow this section on entering data in cells.

Entering a number is done in exactly the same way.  Trailing zeros after a decimal point may not be displayed but you can adjust the number of decimal places displayed by using the decimal icons represented by these symbols:
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To use these icons, select the cell or cells you want to format.  Then click on either button to adjust the number of decimals displayed.

Very small or large numbers that require scientific notation can be entered in a format like this:

to enter 1.08 x 10-4 type 1.08e-4

If a number you type is too long to fit in a cell, you will see ###.  You can change the width of the column to solve this problem.  Special number formatting needs not covered by this brief description can usually be accomplished with the Format pull-down menu, selecting Cells.

So far the spreadsheet is just a memo pad.  But its real power lies in its ability to calculate.  For that you need to enter a formula.  Formulas are typed in much the same way as you would write them on paper except that you must first type an equal sign (=) so that the computer knows you are typing a formula and not just a line of text.  Try typing this simple formula into cell A4:

=2+5

The number 7 will be displayed in the cell after you press Enter but when the cell is active the formula you typed will appear in the formula bar below the icons.  Other math symbols can be used of course, but you should know that three common ones are a little different for the computer.  To multiply use an asterisk (*), to divide use the slash bar (/) and to raise to a power use the caret (^).  Techniques for deleting, editing and special effects can be illustrated now with the information on your spreadsheet.

CHANGING CELL ENTRIES
Suppose you misspelled (or mistyped) your name in A1.  You have several options.  You can delete the entry and type it in again.  A quick way to do this is to make the cell active and press the Delete key on the keyboard.  If you double-click on the cell then you can edit right in the cell by positioning the insertion point marker and using the backspace, insert, delete, etc. on the keyboard.  Or you can simply move up to the formula bar and do the work there (this is useful if you are editing a long formula that is only partly visible in the cell itself).  When you are finished in the formula bar you move the mouse pointer to the green check mark and click on the left mouse button to enter your changes (or just press Enter).

For the purpose of emphasis you may want to make an entry bold or perhaps italicize or underline it.  You can do this by selecting the cell and then using one of the icon buttons shown below:
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Since you are in Chemistry and may want to use sub- or superscripts occasionally in your text, you should know how to do that.  In cell C3 type H2O.  Press Enter and then position the mouse pointer on the cell and double-click as if preparing to edit your entry.  Use the arrow keys to position the cursor bar between the H and the 2.

You can select just the 2 in one of two ways: hold down the Shift key and use the right arrow key to move over the 2 (it is highlighted) or use the mouse pointer while holding down the left mouse button.  Once the 2 is highlighted, pull down the Format menu.

Select Cells, click on the Font tab and mark the box for subscripting.  Then click on OK or press Enter.  This is somewhat tedious, so if you have a lot of sub- or superscripting to do you might want to use the keyboard equivalents.  After marking (highlighting) the characters you want to change, hold down the Alt key while typing the following:



Superscript:  oee Enter


Subscript:  oeb Enter
Finally, alignment of text or numbers in cells or columns or rows is easily accomplished.  First select the region or cell you want to format.  Then choose from among these icons:
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USING FONTS IN FORMATTING

The default font for the spreadsheet is Arial which you will see indicated up near the top left in a little box that has a pull-down menu.  You may occasionally have use for some Greek letters or other special symbols.  Most of these are contained in the Symbol font which you can select from the menu.  Below is a table of some more commonly needed symbols and their keyboard equivalents.  You can either change to the Symbol font and then type the symbol OR type the keyboard equivalent in the default font, select (highlight) the resulting letter and then select Symbol for just that character.
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            [note:  Mac users have no equivalent for the Alt key function and Wingdings 3 is not available]

B.  Starting to use Excel

A CALCULATION USING REPLICATION
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Start with a blank spreadsheet by either cleaning up what you have done or select New from the File pull-down menu or click on the icon:
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Excel files are known as Workbooks and each workbook contains a number of Sheets.  These sheets can be related to one another or completely different--it’s up to you.  The highlighted tab near the bottom of the screen shows the active sheet and you can change sheets by clicking on the tabs with the mouse pointer.  You can name a sheet by double clicking and supplying a name.  You can also insert and delete sheets using, respectively, the Insert and Edit pull-down menus.  A sheet can either contain a spreadsheet, a chart (graph) or a combination of the two.

For this first example we’ll choose something simple like calculating the molar masses of a table of organic compounds.  Rename the first sheet something appropriate and then meet me in cell A1.

Reproduce the spreadsheet below.  Note the formatting and try to duplicate it.


Now that the data has been entered, you are ready to demonstrate computer power.  Place the active cell under the column labeled MM (cell e7) and type the following formula:

=12*b7+1*c7+16*d7

then press Enter (note: the cell references may be in either lower or upper case).

Notice that the molar mass of the first compound, ethanol, appears in the cell and the active cell moves down one place.  The formula, of course, says to multiply the contents of cell b7 by 12, add that to the contents of cell c7 multiplied by 1 and finally add on the contents of cell d7 multiplied by 16.  This gives the molar mass of ethanol.  You could now proceed to type similar formulas in the remaining cells in this column to produce a similar result for the rest of the compounds.  But the power of the spreadsheet is its ability to do this for you by replicating the formula and adjusting it as it does so.

Use the mouse pointer to make the cell containing the formula active again.  Now move the pointer to the lower right corner of the cell.  The mouse pointer should change to a small black cross.  Press down the left mouse button and drag the mouse through the column down to the row containing naphthalene.  When you release the button the formula will have been copied and adjusted throughout the range!

Notice that in the spreadsheet you just made most of the information is labeling, i.e., it is not needed for the calculations.  However, experience shows that good labeling produces spreadsheets that print well and make sense months later when you return to them--not to mention being appreciated by the instructor…

PRINTING A SHEET
To print your work you can either choose the Print icon shown below or the Print Preview icon on the right:


The best choice is the second one because you have the most control over how your printout will look, including margins, headers, footers, portrait or landscape mode, etc.  When you choose either, Excel will print only the active sheet.  Try the Print Preview icon and experiment with a few of the options before you finally print a copy.

SAVING A WORKBOOK
You can save your work on the network if you wish. Ask your instructor if you do not know how. Be sure to bring a virus free disk if you wish to take your work home with you.  Insert the disk into drive A.  Then select the Save icon from the tool bar:



If you haven’t saved the Workbook before you will be prompted for a name for the file and a drive (choose A if saving to disk).  The file name should be something you will recognize later (i.e., avoid names like George, Lucy, Stud, etc.) and is limited to 8 characters (some are not allowed).

EXITING EXCEL

From the File menu choose Exit or simply hold down the Alt key and type FX.

STARTING A NEW WORKBOOK OR LOADING A PREVIOUS ONE FROM DISK
If you want to begin a new Workbook (file) on a subject unrelated to the one you are working with, save your current work and then select New from the File menu (or use the icon).  If you are restarting Excel and want to resume work on a previous Workbook you stored on the network or on your disk, select the Open File icon:



If you select the drive letter where your disk is (A for the disk drive) you will be shown a file list that corresponds to the Excel Workbooks on the disk.  Select the one you want to work on.

PRODUCING GRAPHS FROM DATA
One of the nicest things about modern spreadsheets is their ability to manipulate data in many ways.  For a scientist, graphing is a powerful way to discover new relationships in data.  In Excel, a graph is known as a chart.  There are two ways to produce charts.  An embedded chart becomes part of the sheet with your data on it and will print along with the numbers or text.  You can position it wherever you want on the sheet and size it to suit.  A chart sheet contains only a chart and can be sized or printed full page.  It is a separate sheet in a Workbook.  In both cases, the charts are automatically updated if you change the data (!).  Let’s use some of Robert Boyle’s original data that proved his law:  “The product of pressure times volume of an ideal gas is constant at constant temperature; i.e., PV = constant”.

Boyle’s volume measurements were given in arbitrary units of length because the gas was contained in tubing of uniform cross-section.  The pressure was measured in inches of Hg.  Enter the following data in your spreadsheet (either open a new Workbook, or select Sheet 2):


You might wonder how I formatted that!  I placed the text “volume” and “pressure” in their respective columns first and used those words to size the column width.  Then I typed in the rest.  There are a lot of other ways to get a similar result.

In the column labeled PV a representative formula should be typed to multiply a4 by b4:

=a4*b4

Copy the formula down through the rest of the data.  Then write a formula for the column labeled 1/V.  This is a good time to point out that when you use the decimal adjust buttons to display the right amount of significant digits, the computer actually stores the entire number, not just the rounded version.  When it does calculations it uses the entire number.  So when you round the answers you are doing exactly what should be done when using significant digits in a series of calculations.  That means you should always have your significant digits displayed correctly--no excuses!!!!!

[you might wonder how to format a number like 1396 so that it only shows two significant digits; the solution is to format it as scientific notation and then use the decimal adjust buttons; to get scientific notation select the cell or cells then choose Format from the pull-down menus, select Cells and then click on the Number tab.  You can select scientific notation from the list of possible formats]

You can see from the values of PV that Boyle was apparently right (especially if you have your significant digits correct…).  Another way of demonstrating the validity of Boyle’s law is to graph the data in some suitable fashion.  The goal here is to produce embedded graphs or charts of both P vs. V and P vs. 1/V.  The following steps will get you your first chart in Excel.

1.   Use the mouse or keyboard to select the x values (i.e., the column containing the volume values).  You can select the column heading as well if you like.

2.   Hold down the Ctrl key and select the y values (in this case, the column containing pressure).  It is important to remember when constructing a spreadsheet that the left-most series you select will always be treated by Excel as the x-values or independent variable.
3.   Click on the Chart Wizard icon:

4. In the first dialog box you select the type of graph you want (usually X-Y (Scatter)) then click on Next.

5.   In the next step you can enter a chart title as well as axes titles.  You can also make adjustments to the default grid if you wish and add a legend (usually only needed if you are graphing more than one series).  After you have made your entries, click on Next.

6.   In this final step you can choose to have the chart embedded on the spreadsheet itself or placed on a sheet by itself.  If you choose to place the graph on a new sheet it will be adjusted for some default printing characteristics which are included in the Science Department X-Y format.  If you choose to place the chart on your spreadsheet, you can adjust the ultimate size and aspect yourself as detailed in the remaining steps.  For now, place the chart on your spreadsheet.  Click on Finish.

7.   You can position the resulting chart on the sheet by placing the mouse pointer somewhere inside and holding the mouse button down as you drag the chart around.  You can size the chart by moving the mouse pointer to the mid-point of a side until a double arrow appears and then hold down the mouse button as you drag. [I don’t know why the charts always come out so lopsided, but you should try to square them off a little--thin slivers of graphs are NOT acceptable in a lab report.]

8.   You can size the chart in its current relative dimensions by moving to the lower/upper right corner, looking for the double diagonal arrow and dragging the mouse as above.

Nitty-gritty things:
9.  If you are graphing your data only to see a general trend you will want to draw a smooth connecting line through the points.  Generally, you do this when data is not linear.  To accomplish this, click TWICE on any of the data points.  A dialog box will open up in which the choice of None has been made for the line.  change the selection to Custom and check the Smoothed box.  Then click on OK or press Enter.  Occasionally you can obtain a better “fit” for your data by using one of the curve fitting options found with the trendlines.  Read on.

10.  If you are graphing your data in order to extrapolate or interpolate from it, you will probably want the equation that best describes it.  To do this, click ONCE on any of the data points.  Then go up to Chart on the Tool Bar above and select Add trendline.  A dialog box will open up in which you select the type of function (often Linear for data in chemistry, but sometimes the curves are useful for some experiments); after making that selection, click on the Options tab and select Display Equation on Chart and Display R-squared Value on Chart [remember, the R-squared value is an indication of how well your data fits the selected function--the closer to 1 the better].  You can also force the line to pass through 0,0 if that is appropriate as well as extend it beyond the confines of your actual data (“forecast”).  Click on OK or press Enter.  The trendline is often rather thick.  If you don’t like the look of that (I don’t), double-click anywhere on the line (not on a point) and a dialog box will open in which you can select the line weight.  The next weight down is arguably the best looking.  Click on OK or press Enter when done.

11.  If the axis increments are weird or you want finer tick-marks (the little marks between numbered axis markings) you can double click on the chart to select it and then double-click on the axis you want to change and a dialog box will open.  Choose Scale and then remove the X next to Auto and type in whatever you want.

12.  You can dress up almost anything you want in this fashion.  Just double-click on it and probably something will happen (!).

13.  When you are finished, click anywhere outside the chart to deselect.

This basic sequence is used (pretty much) when you want to make a chart of any data.  Now you want to try and repeat it using the 1/V data as the x-axis.  But wait!  There is a problem.  Remember that the computer will treat the left-most series of data you select as the x-axis data.  But P is to the left of 1/V.  Of course, I made you do this on purpose so you could see how to move things around on the sheet.  If you could exchange the pressure and 1/V columns that would be swell.  You can do so without spoiling your earlier work because Excel automatically updates charts when the sheet data is changed.  Here’s what to do:

--select the pressure column (from cell b3 to b9)


--select the Cut icon: 


--make cell e3 active and select the Paste icon: 

--now repeat this sequence to move the 1/V column so it is between volume and PV; then move pressure back to column d (you could just leave it in column e, but it looks neater back in d!)


If you cut and paste formulas be aware that Excel may try to change the cell references so that the new formula is calculating from cells relative to its new position, so you may need to edit a little.

Now try to make that chart of P vs. 1/V and embed it on the sheet as before (how about to the right of the first chart?).  From your chart you should be able to see why we say P is inversely proportional to V.

Save your work now if you plan to continue (and especially if you plan to quit!!) just in case something awful happens (like a power failure or system crash).  You might also want to try printing a hard copy.
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